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Sponsors
About This Particular Macintosh has been free since 1995, and we intend to keep it that
way. Our editors and staff are volunteers with real jobs who believe in the Macintosh way
of computing. We don’t make a profit, nor do we plan to. Our aim is to produce a fiercely
independent magazine, with multiple formats designed for easy reading rather than showing
ads. The views expressed in these pages have always been our own, and to help prove it we
do not accept direct sponsorships or advertising. We do, however, need to pay for our Web
site and other expenses, so we rely on minimal advertising, sold indirectly via Google and
Yahoo, as well as the support of atpm readers who shop at Amazon.com using our link.
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Welcome
by Robert Paul Leitao, rleitao@atpm.com
Welcome to the July issue of About This Particular Macintosh! The 2011 baseball season
is in full swing. No matter the fact that Michael Tsai and I are Red Sox fans, we’re opening
this month’s issue by paying homage to one of the legends of the game who came to fame
while playing in pinstripes. It’s not his career stats we’ll highlight but a few of the colorful
things he has said over the years and apply those phrases to Apple.

iCloud Envy
The editors of atpm have been celebrating what we call the “personal computing experience” since 1995. The first issue of atpm was uploaded to Apple’s quickly defunct eWorld
service. eWorld was Apple’s first effort at online services. It opened in 1994 and was always
under construction until construction abruptly ended in early 1996 with the termination of
the fledgling service.
We covered the debut of Apple’s iTools service in early 2000. It was a collection of free
services that offered subscribers a mac.com e-mail address. In July 2002, iTools was transitioned to a fee-based service called mac.com. In July 2008, mac.com was renamed MobileMe. In June 2011, iCloud was announced as the new nameplate for Apple’s cloud-based
services. iCloud will offer most of MobileMe’s services but without the annual subscription
fee. Quoting Yogi Berra, “It’s déjà vu all over again.”
For those of us who have endured nine years of fee-based services under the mac.com and
MobileMe monikers, we have a bit of iCloud envy for those just starting now with the newly
named suite of free services.

If the World Were Perfect, It Wouldn’t Be
Continuing with Yogi-isms, Apple caused a rift in the company’s product universe by not
announcing a late June release date for the iPhone 5, and at press time no official mention
of the new phone has been made.
In the absence of real news about the iPhone 5, there’s been much speculation. Some have
suggested that the new iPhone 5 with Apple’s A5 chip and representing the 5th iteration
of the phone will not be called the iPhone 5 but the “iPhone 4S.” Think about that for a
moment. Then disregard it.
Among the hundreds of millions of Apple product users worldwide, many have come to
admire the company’s attention to detail, the intuitive nature of the company’s products,
and the near perfect way Apple devices are designed with the end user in mind. Some
product users are disappointed that Apple didn’t keep to what might be considered a
perfect timetable for the release of this year’s new iPhone.
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But product development takes time, and for a product that may sell over 100 million units
in the year following release, component supplies and manufacturing capacity impact when
the phone can come to market. The iPhone 5 will be released by the end of September. If
Apple attempted to maintain an annual June release date for the latest version of the iPhone,
it would have been “déjà vu all over again” as customers endured long lines throughout the
summer waiting for iPhones in chronically short supply.

It Ain’t Over ’til It’s Over
Apple has now surpassed Microsoft in market capitalization (the total value of the company based on share price times the number of shares outstanding), quarterly revenue, and
quarterly earnings. But efforts to surpass Apple’s old nemesis in other metrics haven’t
stopped.
What began as a bitter feud between Apple and Microsoft over the “look and feel” of
the Mac when Microsoft emulated much of the Mac’s GUI in the development Windows
continues today in a global rivalry that stretches across multiple product lines including
PCs, smartphones, and now tablet devices.
Microsoft remains one of the world’s largest developers for the Mac, and via iTunes Apple
has become one of the world’s most successful developers of software for Windows. We don’t
know when this rivalry will end, but the new version of Mac OS X that becomes available
this summer and the recently updated iMac line of personal computers demonstrate that
Apple is keeping up the fight on the battleground that started it all: the market for personal
computers. Yogi never said it better: “It ain’t over ’til it’s over.”

The Future Ain’t What It Used to Be
We’ll close this month’s Welcome with a reference to one more Yogi-ism. When the first issue
of atpm was uploaded to Apple’s eWorld server 16 years ago, it was a vastly different era of
personal computing than the era in which we live today. We’ve enjoyed the opportunity to
chronicle the development of new products and celebrate the ways in which technology has
enhanced our ability to live and communicate. Our world seems to get smaller by the day,
yet more interesting by hour. “The future ain’t what it used to be,” and the possibilities
of what the future may be get more interesting by the minute.
Our July issue includes:

Bloggable
A monthly summary of Wes Meltzer’s blogosphere news, originating from his Pinboard feed.
This month: iOS/Android/Windows Phone links, iCloud Nine, iOS Everywhere, Lodsys,
Windows 8 vs. iOS, and more.

MacMuser: The Biggest Tossers in Europe
Mark Tennent ponders what all that bandwidth gets us.
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PEBKAC: Lions, and Airs, and iPads, Oh My!
There are three certainties in life: death, taxes, and change. Nowhere is the latter more
prevalent than in the tech industry, and Apple is forcing change for its own benefit, rather
than waiting to respond to what others might do.

How To: Make the Most of TextEdit
A really in-depth look at TextEdit. There are hidden depths in that little program.

Desktop Pictures: North Texas
Chris Turner shares a variety of shots from around his north Texas home.

Out at Five
Matt Johnson’s new series, Out at Five, looks at the workplace and its boundaries from all
angles, revolving around many of the same characters from his former series, Cortland.

The Spinning Beachball
In this cartoon by Grant Osborne, a user gets more than he bargained for with Apple’s
Time Machine application.

Review: MacTVision 3.5
This streaming content management utility meets its goal of the user spending less time
looking for content and more time looking at content.

Review: StoryMill 4.0.1
David Ozab is impressed with this novel-writing software, save for not being able to properly
format the style of his text.

Review: YouTube Converter HD 2.9.1
A simple tool to save and convert YouTube videos that loses the “best value contest” to its
only-a-few-dollars-more sibling product.
Copyright © 2011 Robert Paul Leitao. Robert Paul Leitao is a contributing editor at atpm and is
author of the Posts At Eventide and The iPad Chronicles blogs.
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E-Mail
A Tutorial on Resolution
Those ppi numbers are really just guidelines. What is important is how many pixels of the
image are projected onto a given area of your eye’s retina. In other words, if a 6-inch-wide,
150ppi photo looks OK to you when viewed from a distance of one foot, then if the photo is
enlarged by a factor of a hundred (so it’s 600 inches—50 feet—wide, and has all of 1.5ppi),
and is viewed from a hundred feet away, then it will look just the same to you, because the
two images will be the same size on your retina.
So, bottom line, if those “enormous banners and billboards” are never going to be viewed
close up, then making them from a “150ppi” source image may be perfectly fine.
—Isaac Wingfield

MacMuser: The Lion Wores
Agnetha speaking in English with a Swedish accent, man, that would be hot.
—Steve
•••
Actually, you can still have a Swedish or German speech synthesizer speak English, and it
will indeed have an accent. Although the accent will be pretty heavy. I think an accent
slider control would be awesome.
—Mark Medonis
•••
I only know English. Which new Lion voices would work best for me? I am glad that the
voices are being upgraded. I thought some of the voices were funny, but not practical for
reading. I am a blind user, and I use Allix for reading.
—Edwin Yakubowski
Yes, indeed, Lion’s voices are intriguing, but until it is released we don’t know which voices
will be available.
I have heard most of the English ones, and they have a unique accent for each version
of English. Be they Australian, New Zealand, Indian, American, Canadian or any of the
English speaking parts for the globe. I speak English English as spoken by the Queen, and
to my ears they all sound very accurate.
—Mark Tennent
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MacMuser: New Vistas on Lion
Take a look at the open source SheepShaver. It emulates a PowerPC, and it lets you run
Mac OS 7.5.3 through 9.0.4 on a bunch of systems, including Snow Leopard and even
Windows and Linux. It’s not perfect: installing it is a little bit quirky, and I don’t know
if your bar code scanners will work, but it does a lot of things well. Definitely worth a try.
Installation instructions are at emaculation.com.
—Biff
•••
Ahhh, the old “How much do I need this?” question. I haven’t yet gone beyond Mac OS X
10.4.11, partly because my main desktop machine, a sturdy used G4 AGP, has just refused
to die.
—Avery Ray Colter
We’d love to hear your thoughts about our publication. We always welcome your comments, criticisms,
suggestions, and praise. Or, if you have an opinion or announcement about the Macintosh platform
in general, that’s OK too. Send your e-mail to editor@atpm.com. All mail becomes the property of
atpm and may be edited for publication.
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Bloggable
by Wes Meltzer, wmeltzer@atpm.com

Because No Column Is Complete Without Some iOS/Android/Windows
Phone Links
One iOS User’s Blog of Android Experiences
Ryan Heise decided to keep a running blog of his experiences using Android, coming from
the background of an iOS user. I’m following it, so I can keep up, but he’s had some
surprising insights. Here’s a couple of my favorites: “An unexpected result of switching to
Android is that I pull out my phone significantly less.” Not sure if that’s a good or bad
thing for him! Oh, and:
With all of these add-ons and skins and plug-ins, you have to wonder what
the actual Android experience is. With iOS, the experience is what Apple
dictates. . . Adding customizations [to Android] have, for the most part, made
the experience worse.
Chris Clark’s Month With the Nexus S
We missed this at the time, but after reading Ryan Heise’s experience, I came across Chris
Clark’s log of his own experience with the Nexus S back in March. The short version is
that there are a few small areas where Android is clearly superior (like notifications, why
Apple is revamping them in iOS 5) and most of the rest in which Apple’s greater attention
to polish and better-integrated hardware/software development lead to much better results.
So far, my experience with my friends and colleagues has been the same as Clark’s: if an
Android phone is your first smartphone, it sounds great and you probably love it; and of
course if you’re a hardcore geek or a Richard M. Stallman fan, you’ll prefer Android. But
once you’ve used an iPhone, an Android device is going to seem under-polished. I have a
colleague who said almost exactly that after she switched from a Galaxy S to an iPhone.
Microsoft Makes More Money Off Android Than Windows Phone
In the fun annals of “other things on which companies make money,” Microsoft gets $5 for
every HTC phone running Android because of a patent settlement the two companies made
over IP infringement. Horace Dediu does the math and discovers that Microsoft has made
$150 million off Android, and has only gotten $30 million in Windows Phone revenues to
date, at $15 per license. (He doesn’t clarify if that’s Windows Phone 7 or all versions of
Windows Phone.) That’s quite remarkable, isn’t it?
HTC Cancels Gingerbread Support for Newest Device, then Backtracks
HTC’s engineering department made an announcement—via Facebook—that they were
going to cancel development work on supporting the latest version of Android, Gingerbread,
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on the HTC Desire. Which is basically their newest, greatest device. They said it was
because of memory limitations. (Word on the street is that it was HTC’s Sense custom
user interface that is the memory hog.) However, after a big outcry, two days later they
backtracked and said that they would “cut select apps from the release” in order to “resolve
Desire’s memory issue.” Hmm.
Apple Keeps Plowing Through iPhone Feature Lists
Marco Arment observes that, when the original iPhone was released, everyone complained
that it didn’t meet certain feature requirements: no 3G, no GPS, no copy-and-paste support,
no Exchange support, etc., and predicted that customers would flock to an alternative. But
they didn’t, and with each subsequent release of the iPhone, they have “steamrolled over
almost every meaningful advantage that competitors have.” iOS 5 brings a new notification
system, a hardware camera shutter button, etc. What’s left? Are people really holding out
for an FM radio or removable battery? At some point you have to acknowledge that the
people who make these lists of missing features are the sort of people who would never buy
an iPhone, regardless of its features.
MG Siegler Discovers the Verizon iPhone Slowly Halted Android’s Market-Share
March
Writing in TechCrunch, MG Siegler runs the numbers on the last quarter of iPhone sales in
the US, in which the iPhone became available for sale on Verizon. It turns out, according
to a BTIG Research report, that the iPhone is now both AT&T’s and Verizon’s bestselling phone. According to the market share numbers in the report, the iPhone is actually
outselling Verizon’s Android devices. As he points out, it’s likely that there are still more
Android devices being sold than iPhones, but that’s not bad for one model of phone versus
hundreds. Siegler suggests the doors could really get blown off this one whenever Apple
announces the iPhone 5.

On iCloud Nine
Apple Tries Again With Cloud Computing
At WWDC this year, Apple unveiled their new iCloud service for remotely storing user
data, including the existing MobileMe services plus iTunes Music Store music. This is,
as Timothy Lee writes in Ars Technica, now Apple’s fourth attempt at creating a cloudcomputing service. He argues, and I’m inclined to agree with the argument, that Apple’s
design-first philosophy works wonderfully for creating discrete products but falls flat relative
to Google’s engineering-first culture at creating services. Apple needs to find a way to
develop the services’ requirements, it seems to me, and then design a user interface around
it, rather than the way that they do go about it. MobileMe had lots of resource and
performance issues when it first launched, and it’s possible and even likely that they’ll have
similar issues with iCloud. Lee argues that they should open up a public beta to help iron
out the kinks before open launch, like Google does with many of their products.
What Does iCloud Mean for MobileMe Subscribers?
Macworld takes a look at what the iCloud announcement means for current MobileMe
subscribers: free e-mail, bookmark syncing, and calendar, plus some other features that
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they think will likely be included for free (Galleries, iDisk, etc.) and one Apple has already
made free (Find My iPhone).

iOS Everywhere: Not Just a Slogan
Do The White and Black iPhones Have Different Cameras?
PC World noticed that the photos that the iPhone 4 generates are very different in the
black and white models. They hypothesize that the color difference caused problems for
the sensors, based on the reflectivity of white. In their tests they determined that, although
the quality wasn’t necessarily worse per se, the flash and color performance was definitely
different.
Tony Bradley: Move Over, BlackBerry
Tony Bradley of PC World argues that, with the new features Apple has announced for
iOS 5 and iCloud, iOS will surpass RIM’s BlackBerry as the preferred mobile platform
for business. He goes further than I would—I would argue that all that was holding back
big companies was stuff like BlackBerry Messenger, improved enterprise IT support, and
device cost—but he points out that the e-mail functionality itself will now be better than
RIM’s, in addition to the ability to maintain a device independent of a PC and all the nifty
iCloud stuff. (I think there are going to be security concerns about iCloud in the enterprise,
for what it’s worth. Big companies with IT departments and server farms are still going
to prefer Exchange, which they can host themselves.) It’s a bold challenge. How do you
replace the de facto platform of businesses everywhere? I think it’s already under way.
John Paczkowski: “Consumers Don’t Want Tablets, They Want iPads”
Writing at All Things D, John Paczkowski makes an argument we’ve heard before but that
it’s always fun repeating. He says, based on sales figures and brand strength, customers
are buying the iPad in the same way that they bought the iPod: in replacement for a
generic. Fewer than 15% of respondents in a research survey were interested in a 700 model;
more than 50% of potential tablet buyers say they plan to buy an Apple device, and the
next-closest competitor is Samsung with 13 percent. No matter how many times pundits
declare this to be the Year of the Tablet, it seems that people don’t want “tablets”; they
just want an iPad.
Harry McCracken on iPads vs. Tablets
Following up on John Paczkowski, Harry McCracken, writing in Technologizer, points out
that no device currently on the market has an effective answer to the question, “Why
should somebody buy this [device] instead of an iPad?” He lists 13 ways in which device
manufacturers could differentiate themselves (“more and/or better apps,” “noticeably better
hardware,” “better entertainment services”), but then he points out that very few devices
actually meet those bars. It’s a solid read if you’re curious about why it is that the iPad
does so much better than its seemingly carbon-copied competitors.
Apparently, the Samsung Galaxy Tab 10.1 Isn’t That Great
Clayton Morris of Fox News is unimpressed by the Samsung Galaxy Tab. (Contrast this
with Darren Murph of Engadget.) Morris takes a strong line; the hardware is nice, he
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says, but who really cares about the hardware—in and of itself—when you buy one to use
software? He writes:
I say experience because it’s really the software that matters here, not the
hardware. Sure, the Galaxy Tab feels nice in the the hand, it’s light, it’s fast,
and it takes okay photos but who cares anymore about that?
I’m not sure I agree with his line of reasoning—the reason Apple has been so successful
in the Steve Jobs era is that it marries the great Mac “software experience” that goes
back to the original Mac with a great consumer-level “hardware experience”—but when he
observes that there are “simply too few quality third-party apps built for Honeycomb worth
mentioning,” I think that bears note.
Darren Murph of Engadget Is More Impressed By the Galaxy Tab 10.1
Darren Murph, writing in Engadget, had his hands on a Galaxy Tab 10.1 Limited Edition
at Google I/O. He got a regular-model 10.1, which he says is virtually identical except for
a software point-release difference (Android 3.1 instead of 3.0) and no design on the back.
He was very impressed by the hardware, with particular emphasis on the screen and the
weight and overall form factor of the Galaxy Tab 10.1. But he gives Samsung credit for stuff
that isn’t available, like the Movies section of the Android Market, which he couldn’t use
because it’s only open to Android 3.1 tablets with 3G radio and his model was WiFi-only.
This is what John Gruber calls “grading on a curve.” Murph also notes:
[T]he Android Market still isn’t home to many tablet apps; Apple just announced at WWDC that the App Store is home to some 95,000 tablet programs.
El Goog hasn’t shared its numbers in this regard, but it doesn’t take an awful
lot of poking around to see that it’s nowhere near.
Ouch.

The Latest in Lodsys Case: Lodsys Files Suit, Apple Fires Back
Lodsys Files Suit Against 7 App Developers
In the latest development in Lodsys’ patent-infringement case, which happened right after
the June edition went to press, the company filed suit against seven iOS app developers
(Combay, Inc., Iconfactory, Inc., Illusion Labs AB, Michael G. Karr, Quickoffice, Richard
Shinderman, and Wulven Games) in Tyler, TX. According to Lodsys, they moved up when
they were going to file suit because of Apple’s letter, also released on May 31. I agree
with Florian Mueller of FOSS Patents here, that what they were really trying to do was
pre-empt the possibility that Apple might get a declaratory judgment of non-infringement
in another jurisdiction. The company is acting like they’re positive they’re right, which is
not a surprising position for a patent troll to take. Apple perhaps should’ve moved sooner;
but you never know how these things are going to play out.
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Apple Moves to Intervene in Lodsys Lawsuit Against App Developers
Macworld reports that Apple has moved to intervene in the Lodsys lawsuit against developers. In short, Apple is arguing that it, not the developers Lodsys sued, should be
the defendant in the case, and that they should be able to file a counterclaim against
Lodsys. They are now making the legal argument that they made in their open letter to
Lodsys, that they are “expressly licensed to provide. . . products and services that embody
the patents in suit, free from claims of infringement.” Apple has already released their
proposed counterclaim, in fact, in which they pursue “a declaration that Lodsys’s claims
against the developers are barred by the doctrines of patent exhaustion and first sale.” This
is all starting to get interesting, if a little legalistic.
Florian Mueller’s Analysis of Apple’s Lodsys Filing
Florian Mueller, whom I have been quoting a lot in the Lodsys case, has a very astute
analysis of Apple’s filing to intervene in the case as a defendant. He suggests that he
thinks, even though Lodsys will likely oppose the motion, the company will indeed be
admitted as a defendant; and that Apple’s defense is almost exclusively going to be that
the case is moot, because of the previously mentioned doctrine of first sale (etc). He also
speculates that Apple may be paying the defendants’ legal costs in order to fight other
aspects of the case, because there are defenses that it makes sense for the developers to
offer that it does not make sense for Apple to offer (notably that the patent itself is invalid
or doesn’t apply to the affected products). We won’t know—probably ever—if Apple paid
their costs, because they’re bound by a non-disclosure agreement—but I think this is an
interesting twist. . .and a great analysis.

Next Round of Windows-Versus-Mac: Windows 8 Against iOS
Microsoft Releases Windows 8 Preview, Including Touch Interface
In a fun video to watch, the guys at Microsoft released a preview of how they are building
Windows 8. I think it’s a really interesting look, but I was also really struck by how
Microsoft is now bringing the Windows Phone 7 UI (Metro) to the desktop, in the same
way that Apple is bringing iOS back to the Mac. It’s intriguing. I wonder how well this
will work on non-touch interfaces, and it’s still not proven to me that I’m going to want to
interact with an upright screen with my fingers. (This is the mode in which I like interacting
with my iPad least.) But it’s all very interesting. On the other hand, as John Gruber points
out, the production quality of this video is atrocious. I mean, Microsoft is the most powerful
software company on Earth. Can’t they do better than this?
Why Windows 8 Isn’t a Good Response to the iPad
Jason Snell makes a solid argument about Windows 8 and its general unsuitability as a
response to the success of iOS and the iPad: it’s built on top of conventional Windows.
As soon as the video from Microsoft shows you interacting with ordinary Windows apps
with your fingers, that’s where you lose people. Microsoft isn’t willing to commit to the
tablet as a distinct device, and release an Office developed for a touch interface. Do they
think that sometimes you’ll interact with your hands, and sometimes you’ll interact with a
mouse? I’m not sure I understand.
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Odds and Ends
Justin Williams on Microsoft Hoping for Higher Windows 7 App Prices
Justin Williams—yes, I know he’s become a frequent source here—takes a look at an interesting quote from the guys at Microsoft: “If we can support a higher price point [for apps]
that’s good for developers.” He observes that people complain about paying $5 for an app
(like his Elements editor) on the iPhone or iPad, when the same individuals wouldn’t bat
an eyelash at paying five or ten times that for a Mac version of the app. (I think this is a
perceptual issue; because it’s a phone, or a tablet, and the devices are less expensive, we
wrongly think of the apps as less valuable than their desktop counterparts.) But he thinks
that Microsoft’s strategy, although it might’ve actually worked for Apple if they’d encouraged it, will likely fail for Windows Phone 7 because they’re not the leading platform. As
users compare apps across platforms, they’re going to see, he says, the same app for $2.99
on the iPhone, free with ads on Android and $9.99 on Windows Phone 7. Is that going to
fly?
Google May Not Be Ready for Wallet
There’s a new gold rush in California, but it’s a little more abstract than the last: mobile
payments. Google announced a trial of Google Wallet in New York and San Francisco, using
Near Field Communication. They have a network partner in Sprint, a credit processor in
Mastercard, a bank in Citi, and a lot of large retailers. But the other three major operators
are holding back, and so are Apple, RIM, and Microsoft. (The carriers are working on their
own system, Isis. Although, as Macworld points out, the pilot won’t be until 2012.) So
Wallet goes first, and success might peel operators off of their own system. However, there
are two things they need to succeed: the other carriers must go along, and Google might
have to forego a cut of the loot to get them to the table; and they’re going to need to work
with Microsoft, Apple, and RIM. There’s one last, giant hurdle for Google Wallet: does
anyone want Google knowing that much about them? After all, that’s how they’ll make
money off this.
On the Question of Trusting Your Data to Google
PC World’s Security Alert blog asks one of the questions I had while researching and writing
about Google Wallet: can you trust your financial data with Google, and can they keep it
safe? The glib answer is, they already know everything else about you—why not this? But
security analysts suggest that the data is safe, at least in the current Android requirements
and devices, from hackers and other compromises: the credit card info is stored on a separate
chip; only authorized programs can access the data; and you set your own, Wallet-specific
PIN in addition to the option of setting a phone PIN. The takeaway is that, with these
safeguards, your info should be no less safe than a physical credit card: they argue that
hackers would be better off stealing your (real) wallet. In fact, this sounds more like the
security associated with credit and debit cards in Europe (with onboard security chips) than
Americans’ cheaper but highly insecure magnetically encoded PINs and signature checks.
Dan Frakes Is Not Crazy About Amazon’s Mac Software Downloads Store
Macworld’s Dan Frakes takes a spin through Amazon’s Mac Software Downloads store. (Is
that really the name, guys? Talk about punting on marketing.) He points out that the
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selection is a little lackluster, other than the flagship stuff that Apple isn’t selling (because
I have to imagine Microsoft and Adobe won’t give up 30% of three-digit purchases!). The
experience sounds fairly crappy to me, too: first, you download a disk image containing a
downloader app that is specific to the app you purchased; then, you run the downloader
app that downloads the program itself. And if you buy an app that comes with its own
installer, then the downloader app just downloads the installer, and then you have to run
the installer. (At a million levels of recursion, your head explodes.) Frakes points out that
what Amazon is, in effect, selling you is a digital version of optical media to install; there’s
no handoff of the installation process like with the App Store.
Now Out: OmniOutliner for iPad
How did I miss this? If you’re an OmniOutliner fanatic like me, you’ve tried every outliner
for the iPad in the hope that it would even hold a candle to that amazing app. So far, the
answer has been “no,” at least for me. . .but now OmniGroup’s released the real McCoy!
OmniOutliner for iPad, out now. It’s $20. I haven’t used it much but I am loving it.
This Year’s Apple Design Awards Winners
This year’s Apple Design Award winners, announced at WWDC 2011. Several of these are
excellent apps, and they’re all beautiful. Congratulations!
Brent Simmons Announces the Sale of NetNewsWire
That essential app for so many of us Mac nerds with a prolific reading habit—like yours
truly—has always been NetNewsWire. It’s actually what got me started writing this column
in the first place! I’d never heard of atpm before I started seeing it in NetNewsWire. So
it brings a bit of a tear to me eye when I hear that Brent Simmons is selling it to Black
Pixel Software. He seems really psyched about the guys at Black Pixel, and I know he’s
moving on to other kinds of software. But it’s hard for me, as an end user, as someone
who’s corresponded with the developer who knows how many times about a feature or a
bug or just to say thank you, to move on. Thank you, Brent, in case it isn’t clear. And to
the guys at Black Pixel, I will have my eyes on you. If you do great, you will do great; and
if not, I’ll keep using NetNewsWire 3.2.
John C. Welch: What Lion Server Has to Offer IT Departments
If you’re in an IT department, Lion Server has a lot of benefits for you, John C. Welch
points out. One of the big ones is better (and free) Xsan support; another is built-in iOS
device management. Should make a big difference to Mac-friendly IT departments. (And
probably not so much for the kind of IT departments that begrudgingly support the art
department’s Macs.)
No More Subscription Requirements for iOS Apps
Ars Technica reports that Apple has, in its iOS app review guidelines, loosened restrictions
that require that in-app purchase options for subscriptions be offered at the same price or
better as elsewhere. (This is, I remind you, the infamous Sony Reader rule, but it also
would have affected Amazon, the Financial Times, and other publishers who didn’t offer
in-app subscriptions at all.) After much interest from notables as the European Newspaper
Publishers’ Association and the US Department of Justice, Apple has revised the rules to
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state that apps are no longer required to offer the option for in-app subscription. However,
if subscribers can pay within the app, the app must use Apple’s in-app purchasing APIs
(which means Apple gets their 30% cut) although you’re free to set the price. Interesting.
Copyright © 2011 Wes Meltzer, wmeltzer@atpm.com. You can follow Bloggable in real time on
Pinboard.
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MacMuser
by Mark Tennent, http://www.tennent.co.uk

The Biggest Tossers in Europe
That’s us Brits. We throw away more than any other EC country and much of it still usable.
The bulk of our “stuff” ends up in giant landfill sites even if we recycle it, all because the
market is flooded with dead plastic, paper, and CRT TVs.
We had to make a decision whether to give up something perfectly adequate. Our home
and studio is in an area where we are offered a broadband choice from the best of the UK’s
leading suppliers. Speeds available vary between pathetic to incredible, but at what point
does all the speed become a waste of money?
The best our telephone line could manage was a miserly 5Mbps download and 0.8 upload.
This was after numerous modem upgrades, changing wholesalers, and switching between
various flavours of ADSL. We could also guarantee that at half past five, ADSL would go
down. Exactly the same time we wanted to upload files of the day’s work to servers around
the world. Obviously people were getting home from work and hitting their connections.
But we paid a premium price for business lines and contention ratios meant to make sure
we had priority access.
The move to cable was inevitable, and immediately our upload speed was better than the
best download speed ADSL ever supplied. It is more than adequate for our needs and even
faster than we are supposed to be paying for. Then Virgin told us we can have double that
and shortly double that again. All for an additional £22 per month.

What Will All That Bandwidth Get Us?
At the moment, our 50Mb cable link means we can do everything we need, rapidly and
without the disconnects which plague ADSL. Uploads and downloads of gigabytes of data
are a matter of minutes. The server we are connecting with is the limiting factor rather
than our cable connection. BBC aside, that is, which has been consistently the best in our
experience.
We are a household where, at times, we have four or more smart phones, one iPad, two
Samsung Tabs, seven laptops, and two or three desktop computers running FTP servers and
the like. Plus our own little cloud upstairs serving videos to whoever we give the password
to. In addition, we might be streaming to an AppleTV or the iPad from Crackle. Perhaps
one or two of us are having a video chat to girl/boyfriend left behind in London/Chicago.
If we fancy a movie download, usually about 1.5GB from the iTunes Store, between clicking
on the link and sitting to watch is about the same time it takes to get the foil and wire off
a bottle of Prosecco. With enough time left over to pop the cork through the open French
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doors into the garden to see if we can beat the current distance record. An achievement
I lost recently when my partner uncorked a particularly fizzy specimen. The cork shot up
three metres and sailed past the greenhouse by a gnat’s crotchet to land in the garden pond
some 15 metres away. Personally I think the wind was behind it.

Should We Move to a 100Mb Link and then to 200Mb?
Jeremy Clarkson of Top Gear fame would undoubtedly declaim of course we should, speed
is essential. It didn’t do The Stig much good when he won the court case to reveal his
identity. He lost his job, had a brief appearance in BTCC racing, and seems to have sunk
into history.
But he did give driving lessons to Cameron Diaz. And Tom Cruise if you are into short,
Scientologist actors.
Copyright © 2011 Mark Tennent.
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PEBKAC
by Christopher Turner, cturner@atpm.com

Lions, and Airs, and iPads, Oh My!
In what may be a sign of an impending midlife crisis, I find myself, more and more, beginning
sentences with the phrase, “When I was your age. . .” or some variation thereof. Maybe it’s
because I’m the father of two young boys. Maybe it’s the past five years spent around high
schoolers and college guys and gals through Bible studies I’ve led for a local church. Maybe
it’s just that I’m forty and I’ve seen enough in my life now to see large distinctions.
In seventh grade, we spent about half a semester learning BASIC on the venerable
TRS-80 computer. Then we switched to Turbo Pascal on Apple ][s. (See what I did
there with the ASCII symbols in place of capitalized Is for the Roman numerals? That’s
called “old school.”) When we finished our assignments, we could play Lemonade Stand or
Oregon Trail. I died many a death of dysentery.
And if we weren’t playing games, we were taking what we’d learned and starting work on
our own text-based games.
The first computer to make its way into the household I grew up in was an Apple ][e,
purchased used from one of my high school teachers. He’d bought a new computer from
the same fruit company called a “Mac.” I still have a sharp memory of seeing the little
all-in-one Mac running on the teacher’s desk at his home when we went to pick up the ][e.
That ][e was responsible for every essay paper my last year of high school and four years of
college. Another vivid memory I have is printing out a paper on Salvadoran death squads
for Dr. Mokeba’s poli sci class. (Dr. Mokeba was from Cameroon and immensely proud of
their 1990 World Cup bid.)
I moved to a DOS-based machine, then Windows 3.1, then Windows 95, before coming
back to the Apple fold in 1994 with the purchase of a Performa 6115CD. And I’ve never
looked back.
What’s the point of this stroll down memory lane? So you have context for “When I was
your age, we didn’t have touchscreen smartphones, iPads, or solid-state hard drives. We
computed by swapping out floppy disks, and I mean floppy disks, not those hard, little
three-and-half-inch jobs. And you could screw all your data by bending one of those big
floppies between some textbooks in your backpack.”
In other words: the only constants in life are death and change. And if you keep your hand
in the technology game, you know change happens quickly.
Arguably, the biggest news out of the tech sector last month was what was revealed to
developers at Apple’s Worldwide Developer Conference (WWDC). Mac OS X Lion and
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iOS 5 look to be the best versions yet of those respective operating systems. Apple’s iPad
is the tablet computing market right now. No other company is even close, mainly because
no other company gets it. (HP seems like they have taken a cue from Apple’s playbook;
the new WebOS-based TouchPad is likely the best bet from any manufacturer to take on
the iPad’s dominance. This is because HP, like Apple, is controlling both the hardware and
software experience.)
It’s not just other companies that don’t get it. One thing that hasn’t changed since I got
into the tech game is that Wall Street know-it-alls still don’t understand Apple. “They’re
making the same mistake with the iPod as they did with the Mac. They’re making the
same mistake with the iPhone as they did with the Mac. They’re making the same mistake
with the iPad as they did with the Mac.”
Look at how there are more Android phones out there than iPhones. Sure, but how many
different versions of the Android OS are scattered about through those phones? How many
of those Android phone users can update to the latest version of the OS? (Not many.)
User experience matters, and the iPhone’s is the best because Apple controls the entire
experience, not just part of it.
Look at how there are more Android tablets out there than. . .oh. Wait. That one’s not
holding up so well at the moment, is it? Not to mention that a tablet is a vastly different
type of device than a smartphone. Apple gets this. Manufacturers relying on Android
don’t.
And where are those Android or other OS MP3 players, dominating the iPod? Oh. Right.
Apple hasn’t blown by both Microsoft and Intel in the stock market by being dominated,
by responding to the whims of stock analysts, or chasing other companies. Apple sets its
own agenda, pursues it, and pursues it as close to the perfection of its vision as is humanly
possible. And it reaps the rewards.
I look forward to the continued change our favorite fruit company offers users, and the day
when I can say, “When I was your age, we had to use our fingers to control our iPhone. We
didn’t have any of these fancy eye- or brain-controls you kids have now. . .”
Copyright © 2011 Christopher Turner, cturner@atpm.com.
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How To
by Sylvester Roque, sroque@atpm.com

Make the Most of TextEdit
I’ve had TextEdit, or its predecessor SimpleText, on every Mac I’ve ever owned. That’s
not unusual given that it is pre-installed on every Mac. I tried removing it a few times, but
loading behemoth word processors just to open a Read Me file didn’t make sense. After a
few days, I’d declare the experiment a failure and reinstall TextEdit.
Sometimes I went several days without opening TextEdit. When there was real work to
be done I wanted a real, “full-featured” word processor. Well, I must admit, that when
it comes to what you can do with the current version of TextEdit I was wrong. TextEdit
is quite versatile and can probably do more than you expected. Let’s explore a few of its
capabilities.

What’s on the Menu?
One of the prejudices I have to get over when using TextEdit is that I expect some type of
ribbon or toolbar with all of the formatting options—à la Microsoft Word and others. The
problem is that TextEdit’s interface is a bit more spartan than that. Open a new document
in TextEdit and the familiar ribbons, toolbars, and buttons I’ve come to expect in modern
word processors aren’t there. Most of the features are, but the buttons aren’t. In order to
access these features, you need to know what’s in the menus. Rather than go through each
menu item, let’s take a look at some that you might find useful.
The File menu contains most of the file opening and saving commands expected in a basic
word processor. In addition to text, rich text, and OpenText document formats, TextEdit
also open .doc and .docx files from Microsoft Word. If you receive a Word document but
don’t have Word installed, this might be just the feature you need.
One of the features I forget about in TextEdit is the “Save As PDF. . .” option that’s also
found in the File menu. You can create basic from most Mac OS X applications by choosing
Print, clicking the PDF button, and choosing “Save as PDF.” TextEdit’s “Save As PDF”
option skips a few mouse clicks by going directly to a save dialog.

You Actually Want to Edit Something Before You Save It?
Let’s face it: everyone makes mistakes, and most documents need at least one revision. If
you’re editing a document, TextEdit has some nice features for that as well.
If you create documents with many hyperlinks, you’ll appreciate this feature. Choosing
“Add Link” from the Edit menu brings up a sheet into which you can paste a hyperlink.
When the sheet is closed, a properly formatted link appears in your document. Although
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you can also use the keyboard shortcut (Command-K), that’s not my favorite way to insert
links. Drag a Web link from Safari’s address bar into your TextEdit document and the link
appears properly formatted.
In addition to the usual Copy, Cut, and Paste commands, the Edit menu contains an entry
called Substitutions. From here, you can control the use of Smart Quotes, Smart Dashes,
and Smart Links, among others. The options that are currently enabled are checked.
Enabling Data Detectors from this menu allows TextEdit to use the data detection features
also used by many other Apple applications. With data detection enabled, TextEdit looks
for contact-related data as you type. Enter an address or phone number, and the program
outlines the data with a popup menu. From that menu, you can create or update a contact,
view a map, or view an enlarged version of the contact information. Enter a date and time
with data detection enabled, and it is treated the same way. Instead of contact information
you get iCal-related options for editing and creating events.
Before we leave the text-editing functions behind, there are two other features that shouldn’t
be missed. In the version of TextEdit included with Snow Leopard, a Transformations item
has been added to the Edit menu. This is an easy way to make the selected text all
uppercase, all lowercase, or capitalized (the first letter of each word is capitalized). There
isn’t an option yet to apply sentence case (the first word of each sentence is capitalized), as
far as I can tell. I don’t use these options often, but it’s nice to know they’re there.
TextEdit can also create lists and tables with relative ease. The List and Table menu
commands are found as separate items in the Format menu. Basic tools for creating these
items are there and behave in much the way as they do in other word processors.
There are many more features in TextEdit that make it extremely useful, including
basic support for styles, as well as the spell checking and dictionary options that
we’ve come to expect in so many Mac OS X applications. If you really want to delve
into some of the features we don’t have time to discuss now, give Marius Masalar’s
Discover The Hidden Power of TextEdit a read.
I knew some of Marius’s tips, but I didn’t know about this one, and it’s almost enough to
make me switch word processors right now. If you are a horrible speller, or just a bad typist
as I am, try the auto-complete feature in TextEdit. Type part of a word and press the Esc
key. A list of words beginning with the letters you’ve typed appears. You can navigate the
list using the arrow keys or type more letters and refresh the list by hitting Escape again.
Forget useful, this feature was just plain fun the first time I used it.

What’s Missing?
One of the problems I’ve always had with the various incarnations of TextEdit is setting
margins for new documents. It’s one of the reasons I why usually use a “serious” word
processor. There is a solution, but you’ll need access to a full-featured word processor that
gives you control over a document’s margins. Open a blank document in another word
processor and set the document’s margins the way you like. Save the file in Rich Text
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format. You can now open that document in TextEdit and form a template of sorts for
any documents needing the same margins. I would love to take credit for this idea, but I
actually read it here.
This tip also solved another problem for me. TextEdit seemed to always open new documents with tiny font sizes on my system. Fixing the problem meant a trip to the Format
menu to set a new font and size. While testing the previous hint about saving margins in a
template I created a document with the font and size I prefer. I then saved the document
in Rich Text Format and opened it in TextEdit. The new font and size were preserved. No
more trips to the Format menu just to set the font size for every new document. I could
also have changed this setting by going to the program’s preferences and changing the rich
text font in the New Document tab.
Like easily set margins, Word Count is another feature conspicuously absent from TextEdit.
Word Count is important for many writers trying to meet specific requirements. If this
missing feature is stopping you from using TextEdit, you might want to, try NanoCount.
Kudos to Marius Masalar for finding this solution.
Many writers often find it helpful to work from an outline. Since I usually write documents
from templates, I had never tried to write an outline using TextEdit. In fact, your first
instinct would be to say it can’t be done. But the solution is astonishingly simple: press
Option and Tab simultaneously to put the program in outline mode. You can now use the
Tab and Return keys to quickly navigate through a basic outline.

What Else Can You Do?
TextEdit is primarily a text reader/editor, but that’s not all it can do. The basic document creation and editing features are in the menus, but you’re not limited to text-only
documents.
Suppose you want to send someone a document with some text, the contents of a PDF,
a picture or two, and a short video clip. There may be no need to launch a behemoth
word processor or page layout program, or to send multiple files to be opened in different
programs. Give TextEdit a chance to build your document. In the course of testing TextEdit
for this article, I have dropped text, PDFs, images, and video clips into a new document.
TextEdit handled all of these files easily. It places the object at the current insertion point.
Instead of a true word wrap, it treats the object as though it were a large text element.

Did You Know TextEdit Can Speak?
Speech functions have been part of the Mac’s capabilities for some time now. VoiceOver
and speech recognition are invaluable tools for some users. Well, TextEdit also makes good
use of your Mac’s speech capabilities. How would you like to have a document read to
you? It’s as simple as opening a document in TextEdit, selecting the text to be spoken,
and choosing Edit . Speech . Start Speaking. If you don’t like the voice TextEdit is using,
open the Speech pane in System Preferences and choose a different system voice and rate
of speech.
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If you find this feature useful and would like to batch process files into your own “mini
audiobook” it should be possible using AppleScript or Automator. I’m working out a kink
or two in the process, and I will post the results when the problem is solved. If you would
like to try this on your own, read the comments by chrischarm and ephramz in this thread.

Final Thoughts
Given that I have used other word processors for so long, you might be wondering why I
took a look at TextEdit at all. First, it fits splendidly with the theme of this series: before
you buy other software, take a serious look at the software already installed on your Mac.
It might meet your needs nicely. Second, TextEdit often loads faster than its larger word
processor cousins. On my MacBook Pro, for example, TextEdit opens to a blank document
in about two seconds. Some word processors haven’t even gotten past the splash screen at
this point.
That’s it for this month. Thanks to Professor Michel Clasquin-Johnson for suggesting this
article. Next month, we’ll look at a few remaining items in the Utilities folder, examine the
iLife suite, or get a first impression of Lion, depending on when it’s released.
Copyright © 2011 Sylvester Roque, sroque@atpm.com.
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Desktop Pictures
Christopher Turner, cturner@atpm.com

North Texas
We need new desktop pictures each month. Write to us!

This Month’s Desktop Pictures
Chris Turner shares a variety of shots from around north Texas, including Cowboys Stadium,
behind the scenes at a movie theater, and woodland scenery.

View Pictures

Contributing Your Own Desktop Pictures
If you have a picture, whether a small series or just one fabulous or funny shot, please send
it to editor@atpm.com and we’ll consider publishing it in next month’s issue.

Previous Months’ Desktop Pictures
Pictures from previous months are listed in the desktop pictures archives.

Downloading All the Pictures at Once
Some browsers can download an entire set of desktop pictures at once.
Safari Create a workflow in Automator with these three actions:
1. Get Current Webpage from Safari.
2. Get Image URLs from Webpage. Get URLs of images linked from these
webpages.
3. Download URLs.
iCab Use the Download command to “Download all linked files in same folder” and configure the limits to download only the linked images.
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OmniWeb Choose “Save Linked . Images. . .” from the File menu.

Placing Desktop Pictures
Mac OS X 10.3.x Through 10.6.x
Choose “System Preferences. . .” from the Apple menu, click the “Desktop & Screen Saver”
button, then choose the Desktop tab. In the left-side menu, select the desktop pictures
folder you want to use.
You can also use the pictures with Mac OS X’s built-in screen saver. Select the Screen
Saver tab which is also in the “Desktop & Screen Saver” System Preferences pane. If you
put the atpm pictures in your Pictures folder, click on the Pictures Folder in the list of
screen savers. Otherwise, click Choose Folder to tell the screen saver which pictures to use.
Mac OS X 10.1.x and 10.2.x
Choose “System Preferences. . .” from the Apple menu and click the Desktop button. With
the pop-up menu, select the desktop pictures folder you want to use.
You can also use the pictures with Mac OS X’s built-in screen saver. Choose “System
Preferences. . .” from the Apple menu. Click the Screen Saver (10.1.x) or Screen Effects
(10.2.x) button. Then click on Custom Slide Show in the list of screen savers. If you put
the atpm pictures in your Pictures folder, you’re all set. Otherwise, click Configure to tell
the screen saver which pictures to use.
Mac OS X 10.0.x
Switch to the Finder. Choose “Preferences. . .” from the “Finder” menu. Click on the
“Select Picture. . .” button on the right. In the Open Panel, select the desktop picture you
want to use. The panel defaults to your ~/Library/Desktop Pictures folder. Close the
“Finder Preferences” window when you are done.
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Out at Five
by Matt Johnson, mjohnson@atpm.com

Getting Approval

Taking Charge
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Introductions

Orientation

Making Mischief
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What a Surprise

Bonus Time

Motivation
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Copyright © 2011 Matt Johnson.
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The Spinning Beachball
by Grant Osborne, http://grantosborne.com

Copyright © 2011 Grant Osborne.
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Software Review
by Sylvester Roque, sroque@atpm.com

MacTVision 3.5
Function: Brings TV/streaming content to your Mac.
Developer: MacTVision LLC.
Price: $40
Requirements: Mac OS X 10.4.
Trial: Fully-featured (3 days).

For as long as I can remember, I’ve been in the habit of watching television while working
on the computer. Usually that’s easy enough, but since we rearranged things recently the
computer and television are no longer in the same room. I could use my 2008 MacBook
Pro while watching TV, but it gets a little “toasty” on my lap. I knew there were options
available for watching television on the computer, but many of these options were Windowsonly. There are also sites such as Hulu that provide program feeds, but searching the sites
can be cumbersome. Sometimes you need to search multiple sites and you may, or may not,
find the content you want. There has to be something better out there. Can MacTVision
solve my problem?

What Is MacTVision?
MacTVision is at heart a simple piece of software that’s almost like a personal assistant
gathering content you like from the Internet. If someone is streaming news, sports, some
network television, YouTube, Hulu, and more, MacTVision locates it and brings it right
to your desktop. The company’s goal seems to be to have you spend less time looking for
content and more time looking at content.

Getting the Hardware Up and Running
If you are looking for an Internet TV setup that is difficult to set up, this is not the program
for you. Unlike some hardware-based options, getting started is about as simple as things
get. If you are reading this article on a broadband connection with anything remotely
resembling a modern Mac you’ve got the necessary hardware.
I tested my connection speed at Digital Landing. My connection was only slightly above
the US national average, and even with my wife playing World of Warcraft on her Gateway,
streaming video playback on my Mac was smooth. Much of the available Internet content
is still Flash-based. If you can usually play that back smoothly your connection is probably
good enough.

Setting Up and Configuring the Software
Installing MacTVision couldn’t be easier. Not surprisingly the program’s icon looks like
a TV. Drag that icon into your Applications folder. That’s all there is to installing the
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software. Feel free to place aliases anywhere you like for convenience. If you need a more
visual set of directions, try this video.
Now that the program is installed there’s just a bit of configuration needed. Fortunately
it’s a simple process anyone can complete. Open MacTVision’s preferences and do the
following:
1. In the Location tab, choose your country in the combo box. Not all content is
available in all countries, and this is the first step in addressing that problem
area.
2. Checking the “Hide blocked content” option will reduce the amount of content
you have to wade through by only showing content available for viewing in your
country. In my case, having these options set reduces the number of feeds by
about 1,700. Leaving this option unchecked provides you with more potential
content, but there’s no guarantee the additional feeds will actually play (often
due to licensing issues).
Once completed, the screen will look something like this:

Setting Location Preferences

If you are usually in the habit of keeping media components like Flash and QuickTime up
to date, you may not need to do anything else for things to work properly, but it is always
a good idea to check anyway by clicking the Software tab.
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Setting Software Preferences

If QuickTime, Flip4Mac, or Flash is out of date, clicking one of these buttons takes you to
the appropriate download page.
I didn’t make any adjustments to the Options tab because I generally like the stock settings.
If you want to control options such as whether the video opens full screen or whether
the player launches in full screen mode, this is the place to go. The settings are pretty
straightforward so feel free to experiment a bit.

Finding Something Good To Watch
At launch, MacTVision opens in a single window that for all practical purposes can be
divided into three distinct areas. The interface is consistent about what kinds of information
appear in each section of the window. This makes learning the program easy.
The border of the main window is slightly darker than the rest of the window and about
the width of what you see in a typical Finder window. This portion of the window is sort of
“mission control” for the entire program. From here there are numerous buttons to narrow
down the type of content that appears in the rest of the window. There are also buttons
to add your own content, update the list of streams, access the programs preferences, or go
directly to the MacTVision Web site.
The buttons which filter content are for the most part self-explanatory. The Home button
is the default when the program opens. All types of content are listed in the pane below
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this button. This isn’t a bad way to just browse content if you are not sure what you’re
looking for, but if you know even a partial title, click the All Content button. The list of
content is the same, but now there is a search field just above the list of streams. There’s
also a list of letters of the alphabet to quickly jump to titles beginning with a specific letter.

Search All Content

The buttons marked Streams, Video, Radio, Apps, Favorites, and Featured all filter content
to only the type associated with a given button. Below the button is a search field where
one enters the search term. Content matching your search appears in the pane below the
search field.

Enough Searching; Let’s Watch Some Video
If you’ve followed along thus far, you’re probably interested enough to wonder how to
actually play content once you’ve found it. Like most other aspects of this program it’s
actually quite easy. Here’s how I find and play an episode of Bones:
1. Click the TV button since I know I’m looking for a TV show.
2. Enter the word “Bones” in the search field.
A series of results will appear just below where you entered the search term. Clicking one
of the results fills the remainder of the window with a program description. As you click on
each program, the description changes. The list of available episodes is also updated in the
bottom of the window. Playing an episode is as simple as clicking the blue play button.
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Search Results

From there, the content in question pops up in a window on screen and is ready to play.
How much control you have over playback depends in part on whether the content is Flashor QuickTime-based. At the left side of this window are buttons to add the program you
just found to your favorites. You can also report dead streams that consistently refuse to
play.

What About Favorite Content
Before we leave our discussion of the mechanics of MacTVision, we need to look at what
happens if you click the Add Content button. You can’t miss this button it’s marked by
a rather large + sign. This button is useful if you know the information for a stream that
MacTVision isn’t aware of. This brings up a Suggest Content screen. You can fill in a
URL, description, content type, and other metadata for content you would like to suggest
for inclusion.
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Add Content

The Viewing Experience
I actually liked watching programs on my Mac using this program. I know I could go to
individual sites like Hulu, but I usually find that cumbersome. It’s a particular pain if you
have to go to more than one site. MacTVision solves a lot of these problems by gathering
content in one easy-to-search place. Setup is about as easy as this type of program is going
to get. Even a non-techie can probably set this up in no time.
On my 2008 MacBook Pro with 4 GB of memory, Mac OS X 10.6.7, and a 2400 monitor,
playback was quite smooth and really indistinguishable from playback on a television. Even
with multiple programs open and other network activity taking place over both wired and
wireless networks, I didn’t experience a problem with video stalling. I did have a few
problems with what might have been dead streams when I tried some of the Internet
radio stations, but that could easily be a function of server issues or stations no longer
broadcasting that have not been removed yet.

The Rough Edges
It took me a bit longer to test this software and write the review than I anticipated. One
side effect of this is that my opinion of the program changed over time. At the beginning
of my test period, version 3.4 was the current version of the program. For some reason,
that version of the program often took as much as 50 seconds to launch from the time I
launched the program to the time I was able to conduct a search. During that time, if
I checked the Dock I usually saw the dreaded “Application Not Responding” message for
several seconds. Version 3.5 seems to have fixed this issue. The program now launches in
three or four seconds under the same conditions that used to take far longer.
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One “rough edge” that remains is something I hope will be fixed soon, though I think the
problem may lie with Adobe Flash rather than MacTVision. I currently run my Macbook
Pro with two external monitors and the laptop screen all active. When MacTVision is open
in full screen mode on my main screen, I cannot click on any programs on the other screens.
Doing so reduces the video I’m watching back to small screen mode.
The other thing I would appreciate is a minor change in the search results window. The
results adapt almost “on the fly,” and that’s good. The problem is that the text in the
results window seems a bit small to me. That probably means it’s time for new glasses, but
it would be nice to be able to adjust the size of this text—especially if you are going to use
it on a media Mac connected to a television.

Is It Worth the Cost?
Initially I was going to rate the program as Okay due to the delay during launch and
similar but shorter delays every time I searched for something. The recent release of
version 3.5 seems to have resolved these issues as well as several others. The ability to handle HD content was also added to version 3.5. If you’d like to see what’s
new and improved in version 3.5 you’ll find the information on the Web site. Version 3.5
is new enough, though, that the screenshots on the support site cover the previous version.
For me, I like version 3.5’s performance and implementation enough that I think it is worth
a rating of Excellent. Take advantage of the three-day trial period and use the time to see
if the content you want is available. If it is, the program is well worth the money. The
developers seem to be serious about improving the program, and $40 is a more than fair
price for a lifetime subscription. I liked it enough to purchase a subscription and may add
a second one for my media Mac.
Copyright © 2011 Sylvester Roque. Reviewing in atpm is open to anyone. If you’re interested, write
to us at reviews@atpm.com.
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Software Review
by David Ozab, http://fatherhoodetc.wordpress.com/

StoryMill 4.0.1
Function: Novel writing software.
Developer: Mariner Software.
Price: $50 (download); $25 (upgrade)
Requirements: Mac OS X 10.6.
Trial: Fully-featured (30 launches).

“I’m going to write a book.” One of those insane ideas that pops into your head from time
to time—most often at three in the morning. Chances are you push it right back out of
your head again, but what if you can’t? What if the story is there, begging to be told, and
you—writing newbie that you are—have no idea where to start?
You could sit down with a notebook, or open up your favorite word processor, and start
writing, but even if you beat the blank page for a while, sooner or later you’re going to
get stuck. Maybe you’re having trouble organizing your ideas, or you’re forgetting which
character is which, or who did what when. It’s a lot to keep in your head, so you write pages
and pages of notes or save multiple files with background stories and character descriptions,
and it’s all a great big mess. Isn’t there a program that can keep all that stuff together
where you can find it and maybe even help keep it straight?
Actually there are a few of them, and they compete with each other for both novice and
experienced writers. I got a chance recently to try out one of them: StoryMill 4.0.

Getting Started
StoryMill offers a couple of options upon launch. In the File menu, you can choose New or
“New from Templates.” The “Novel (with submission tracking)” option is probably the best
choice. As you’ll see later, this option includes a panel to list agents and publishers, and
we have to hope that you’ll find at least a few interested in what you’re writing (once you
put in the requisite research and leg work through writers’ groups, conferences, etc.—there
are some things that no software can do for you).
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New Template

Now you have an untitled project. To the left you’ll see a menu listing Novel, Characters,
Scenes, Locations, Tasks, Research, and Submissions.

Let’s Take a Closer Look
Novel
Novel is where you start writing, beginning with Chapter 1—as good a place to start as
any. Most writers have a solid idea where they want to begin, even though they’ll probably
cut it later on. So far, not really anything beyond what you can do with a word processor.
Scenes
Scenes is a great place to write the pivotal parts of your work as they come to you. Let’s
say you’ve got a first act climax, or an interesting plot twist. You’re not sure how to get
there, but why wait? Get it out now and find the right place for it later.
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A List of Scenes

StoryMill’s greatest strength is its scenes-based approach to writing. Writing chapter-bychapter can force you into an overly chronological approach. I know this from personal
experience: the first draft of my first manuscript is chronological and chapter-based. I’m
not sure if I could have told this story any other way, but looking back I wish I’d had the
flexibility to try. Some of the edits and revisions I’m now considering might have come to
me more quickly in a scenes-based approach.
Characters
Characters is where you keep your characters. What they look like, their backgrounds,
motivations, all that backstory stuff that you started to put in Chapter One until you
realized that you were thirty pages in and nothing had happened yet. Your reader doesn’t
need all this information up front, but you do. This is where you keep it until you’re ready
to reveal little by little.
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A Sample Character

Locations
Locations are the setting for your scenes. Here, for example, you can put in all the architectural details of a building without revealing them on page one (boring). Again, what
you need to know to write isn’t necessarily what reader needs to know to read (yet).
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A Sample Location

Tasks
Tasks is a generic tag—kind of a catch-all. You can delete this if you want or make other
tags to keep track of things outside the basic categories provided in the template.
Research
Here’s where you keep all the information that keeps your story “true to life.” Someday
(we hope) you’ll be reading your book at a big book signing event. The last thing you need
is a self-proclaimed expert questioning you on the breeding and training of quarter-horses,
or the fatality rate of American test pilots in the 1950s, or how many bishops attended
the First Council of Nicea. No fact is too obscure for some know-it-all to correct, but you
can be prepared. Just make sure that any references you find in Wikipedia are properly
sourced.
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Sample Research

Submissions
Submissions (as stated earlier) is where you track submissions of your completed and thoroughly edited manuscript to agents and editors. This is also a good place to store contact
information prior to submitting, and you can export entries to Address Book to print mailing labels.
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A Sample Submission Contact

Menu options in each window allow you to interconnect characters, scenes, and locations
by storyline as well set a draft status (e.g. first, second, needs work, final). These draft
statuses can be edited in Preferences.

But Wait, There’s More
Looking across the top toolbar, we see this set of buttons:
Insert
Insert adds a new submenu to the selected menu item on the left. Here’s an easy place to
add new scenes, characters, or locations. Another way to do this is by “right-clicking” the
menu item, or by selecting the “Add a New _” button at the top of the open window.
Snapshots
Snapshots is a useful editing feature. You can save any scene as a snapshot, and then
compare original and revised scenes side-by-side in a single window. (I’ve done this with
two open windows in Word—it’s a real pain).
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How Dare I Correct Robert Louis Stevenson?

Full Screen
Full screen toggles the view to text only. Select this option if you want to write without
on-screen distractions. The Esc key toggles back. The only problem I had with this feature
is that, every time I toggled, the cursor jumped back to the beginning of the text. A minor
annoyance, but one that should be easily fixed in an update.
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Writing in Full-screen Mode

Timeline
The timeline lets you lay out your entire story chronologically, with overlapping subplots
on separate lines. Coming from a music recording background, I love timelines—I sketch
them out on big sheets of paper laid out on the floor. The timeline is scalable from hours to
centuries—a good feature for stories that vary their treatment of time. Managing a complex
timeline can be tricky, though, if, for example, you have one scene that takes place in an
hour occurring in the same time frame as a broad setting or transition scene that covers
several months. After a while, my eyes started to bug out a bit as I scrolled and scrolled
to get to the point where the two overlapped. I’m not sure how to fix this; it may just be
a shortcoming of any timeline layout.
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A Sample Timeline

Progress Meter
Next to the timeline is the progress meter. I love this. It’s like a less threatening version
of Write or Die. Every writer needs to set a goal, or nothing gets done, and having an easy
way to set a word limit—“I will write 1,000 words on this scene today if it kills me!”—is a
good way to keep from getting distracted from wasting too much time on character traits,
setting details, research minutiae, and any other self-imposed distractions that keep us from
doing what we’re supposed to be doing: writing.
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Keep Writing!

Etc.
To the right of the progress meter are four more handy tools: Annotate, Jump To, Highlight,
and Search. Annotate lets you insert a hyperlink to an annotation; Jump To, as expected,
jumps to the next annotation; Highlight and Search are self-explanatory.

Importing and Exporting
StoryMill’s file format is proprietary, so the Import and Export features are essential. Import will bring any common word processing file into StoryMill, dividing the chapters as
long as they are clearly labeled (e.g. “Chapter One”). It has no clue what to do with
prologues, epilogues, or non-traditionally titled chapters.
I tried importing my manuscript-in-progress—a very large file—to see how it did. It divided
the chapters correctly but screwed up the formatting. Even if I fixed the formatting, I’d
have to add scenes, characters, and locations by hand—not really worth the effort. In this
case I think I was expecting more of StoryMill than it was designed to do.
Exporting is straightforward. Select File . Export, choose “Chapter text” in the Template
list, select a file format from the pop-up menu on the bottom bar, and click Export.
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Sorry Mr. Stevenson, We Are Not Accepting Submissions at This Time

Then format in your word processor of choice, because StoryMill defaults to single space
with no drop downs at the beginning of chapters and indents on first paragraphs but
not subsequent paragraphs. Some of these issues can be fixed in StoryMill . Preferences .
Editor, but not all of them—I was stumped on drop-downs—so I’d proof in a word processor
before printing anyway.
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Mr. Dickens, on the Other Hand, Now Has Representation

This is my one complaint about an otherwise wonderful software package. Formatting
requirements do vary somewhat from publisher to publisher, but there are some consistent points like double spaced text, chapter titles dropped down about a third of a page,
and indenting on all paragraphs except the first one. To have a “novel writing” application marketed to an extent to beginning writers default to slush-pile worthy formatting is
unacceptable and just a bit cruel.

And That’s Why I Almost Love It
After spending a long weekend playing with StoryMill, I find it to be a very powerful writing
tool, better for fiction than non-fiction, and better for starting from scratch then revising.
It has so much in its favor and is a great value for $50, but as much as I want to give it an
Excellent rating for everything it can do, I can’t get past the formatting issue. My advice:
buy it if you’re looking for a tool to help you get going on a new project, especially if you
find yourself wanting to play with chronology and subplot. But be ready to export and
edit in word processor before you send it to agents or publishers. Otherwise, you’re wasting
both your time and theirs.
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Copyright © 2011 David Ozab. Reviewing in atpm is open to anyone. If you’re interested, write to us
at reviews@atpm.com.
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Software Review
by Lee Bennett, lbennett@atpm.com

YouTube Converter HD 2.9.1
Function: Downloads and converts YouTube videos.
Developer: Enolsoft
Price: $29
Requirements: Mac with 1 GHz Intel processor, Mac OS X 10.5.
Trial: Feature-limited (limitation on conversion duration).

Enolsoft specializes in a variety of multimedia conversion software. Among the company’s
video tools for Mac is an application that removes virtually all complexity from saving a
YouTube video to a computer and converting it to many popular formats.

ATPM 17.07

55

Review: YouTube Converter HD 2.9.1

YouTube Converter HD will batch download any number of videos in one step.
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After all desired URLs are pasted in, and the download destination is selected, it’s just one click to begin
downloading all the videos.

For some people, just downloading YouTube’s .FLV Flash files is the goal. If so, the job is
now done. There are many Web sites such as KeepVid that will do the job for free. Even
Enolsoft has a free product, YouTube Downloader HD, which batch downloads .FLV files
the same way as YouTube Converter HD. However, the difference with YouTube Converter
HD, as its name conveys, is the ability to convert those .FLV files into a choice of many
popular formats, including audio-only files.
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Downloaded videos immediately show up in the Convert section, ready for conversion to one of many popular
video or audio formats.

In addition to downloaded YouTube URLs automatically appearing in the Convert section,
I can instead click Add Files to convert .FLV videos already saved to my computer. One of
several user interface improvements I’d like to see is the ability to drag files to the window
as an alternative to clicking Add Files and using the standard dialog box to navigate and
find desired files.
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Settings to be used for conversion. (Yep, that’s a typo in the application.)

YouTube Converter HD allows me to individually specify the conversion format for each
file, or keep the “Apply to all” checkbox enabled to quickly set the format for all files. I was
somewhat disappointed that most of the settings in the screenshot above weren’t editable,
in spite of the combo box interface that suggested they were. But it turns out that various
fields can be edited depending on which conversion format is selected. In the case of 720p
Apple TV-friendly MP4 files, the video and audio bitrates are the only adjustable setting.
However, when I chose a basic QuickTime .MOV as the conversion format, even though
H.264 and AAC remained the only available video and audio codecs, I could adjust all other
settings.
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The number of conversion formats was pleasantly surprising. In addition to the expected
Apple-preferred formats for iTunes, iPods, iPhones, iPads, and Apple TVs, YouTube Converter HD can also convert to Windows Media, RealPlayer, MPEG, etc. It can even create
videos compatible with non-Apple devices including PlayStation, Zune, Xbox, Galaxy Tab,
Xoom, most any device that supports 3GP or MP4, and more.
Although the ability to choose from dozens of conversion formats is most welcome, the user
interface to choose them is somewhat less welcome. Once the conversion format selection
interface is opened, its navigation is handled almost entirely by mouseover events, which
makes getting around a little awkward. It’s hard to explain without showing it, so here’s a
short video demonstration.
As shown in this video, once I clicked the “Convet to:” [sic] menu, at no time during the rest
of this video did I click the mouse until I was ready to select a format. The mouseover-style
navigation can be a little tricky.
Notice a few things in this video. The categories on the left side are activated as soon as
the mouse hovers them. This means I have to be careful to move the mouse directly to the
right to browse through the formats in that category. Around 22 seconds in the video, it’s
apparent that I had some trouble staying on the iPad category.
Then note throughout the video how I only hover the mouse over what looks like a “down”
button underneath the list of formats. It looks like something I should click, but the
list begins scrolling just from hovering over it. I can’t scroll any slower or faster this way.
Thankfully, I can instead scroll with the wheel on my mouse. Also of interest is the cropped
appearance of the faux button for scrolling back up.
Lastly, something about the creation of this sheet window is such that the Android Video
category doesn’t always want to register. This phenomenon can be seen at the end of my
video.
Once the desired conversion settings are made, a single click of the Convert button is the
last step. Be prepared to wait, especially if an HD format is used. In spite of the Intel
CPU requirement, my observation is that YouTube Converter HD is not multi-CPU aware.
I tested the application on an 8-core Mac Pro and never saw more than a single core peg
at its maximum at any time during the conversion.

My menu bar CPU monitor only pegged various individual cores during conversion. Activity Monitor only
reported an average of 115% CPU load. A multi-CPU aware application should generate a much higher load.
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By comparison, I made a conversion on the same .FLV file with MPEG Streamclip, and my CPU monitor
looked like this, with an average CPU load of 375%.

Enolsoft’s product lineup and pricing is an intriguing topic. The first thing to consider is
the feature of downloading YouTube .FLV files. This function really isn’t part of YouTube
Converter HD’s $29 price, considering Enolsoft has a separate, free application for the task.
What one pays for in YouTube Converter HD is the conversion capabilities. However, this
application is only able to use .FLV videos as the source format. It will not convert from
any other format.
Also in Enolsoft’s product lineup are two separate utilities for converting most any format
to iPad- or iPhone-friendly formats. That’s right, a single $29 utility for iPad formats,
and another for iPhone formats. They’re like the reverse of the YouTube Converter HD
software. Instead of going from just one format to any format, the iPad or iPhone converters
accept most anything as the input format, and the only output formats available are those
compatible with the respective devices.
The least expensive product on the list (not counting the free YouTube downloader), at
$25, is YouTube to MP3 Converter.
On the opposite end of the price list is the $35 Enolsoft Video Converter. It doesn’t
automatically download YouTube videos, but it does convert from any supported format
to any other format, and it includes some basic editing and effect functions for video.
It shouldn’t be difficult to figure out why I devoted a few paragraphs talking about Enolsoft’s
other products. If YouTube Converter HD were the only product Enolsoft made, a $29 price
tag seems very reasonable to me. However, I’m not so sure about the logic of charging $25
for downloading YouTube videos (especially considering Enolsoft’s free product for this
task) and only being able to convert them to one of seven audio formats, when just $4 extra
includes conversion to many different audio and video formats. Similarly, for just $6 above
YouTube Converter HD’s price, I can get Enolsoft’s application that accepts many different
formats as the input source and get simple editing capability as well.
In summary, my assignment of a Good rating on this application comes from two factors: a
somewhat quirky interface and odd pricing in comparison to other Enolsoft products. My
recommendation: spend the extra $6 and use the full Video Converter along with the free
YouTube Downloader HD application.
Even better would be for Enolsoft to abandon YouTube Converter HD and incorporate the
downloader function into the full Video Converter application. While doing that, price the
YouTube to MP3 Converter to an amount more appropriate for its single function, and
rename it as YouTube to Audio Converter since MP3 is not the only file format choice
available.
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Otherwise, reduce the prices of YouTube Converter HD and YouTube to MP3 Converter to
be a better value in comparison to Video Converter for those who do not need all of Video
Converter’s capabilities.
Copyright © 2011 Lee Bennett. Reviewing in atpm is open to anyone. If you’re interested, write to
us at reviews@atpm.com.
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FAQ: Frequently Asked Questions
What Is ATPM?
About This Particular Macintosh (atpm) is, among other things, a monthly Internet magazine or “e-zine.” atpm was created to celebrate the personal computing experience. For
us this means the most personal of all personal computers—the Apple Macintosh. About
This Particular Macintosh is intended to be about your Macintosh, our Macintoshes, and
the creative, personal ideas and experiences of everyone who uses a Mac. We hope that we
will continue to be faithful to our mission.

Are You Looking for New Staff Members?
atpm is looking to add more regular reviewers to our staff. Though all positions with About
This Particular Macintosh are volunteer, reviewing is a great way to share your product
knowledge and experience with fellow members of the Macintosh community. If you’re
interested, contact atpm’s Reviews Editor, Paul Fatula.

How Can I Subscribe to ATPM?
Visit the subscriptions page.

Which Format Is Best for Me?
• The Online Webzine edition is for people who want to view atpm in their Web
browser, while connected to the Internet. It provides sharp text, lots of navigation
options, and live links to atpm back issues and other Web pages.
• The Offline Webzine is an HTML version of atpm that is formatted for viewing
offline and made available in a Mac OS X disk image. The graphics, content, and
navigation elements are the same as with the Online Webzine, but you can view it
without being connected to the Internet. It requires a Web browser.
• The Print PDF edition is saved in Adobe PDF format. It has a two-column layout
with smaller text and higher-resolution graphics that are optimized for printing. It
may be viewed online in a browser, or downloaded and viewed in Apple’s Preview or
Adobe Reader on Macintosh or Windows. PDFs may be magnified to any size and
searched with ease.
• The Screen PDF edition is also saved in Adobe PDF format. It’s a one-column
layout with larger text that’s optimized for reading on-screen.

How Can I Submit Cover Art?
We enjoy the opportunity to display new, original cover art every month. We’re also very
proud of the people who have come forward to offer us cover art for each issue. If you’re a
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Macintosh artist and interested in preparing a cover for atpm, please e-mail us. The way
the process works is pretty simple. As soon as we have a topic or theme for the upcoming
issue we let you know about it. Then, it’s up to you. We do not pay for cover art but
we are an international publication with a broad readership and we give appropriate credit
alongside your work. There’s space for an e-mail address and a Web page URL, too. Write
to editor@atpm.com for more information.

How Can I Send a Letter to the Editor?
Got a comment about an article that you read in atpm? Is there something you’d like
us to write about in a future issue? We’d love to hear from you. Send your e-mail to
editor@atpm.com. We often publish the e-mail that comes our way.

How Can I Contribute to ATPM?
There are several sections of atpm to which readers frequently contribute:
Segments: Slices from the Macintosh Life
This is one of our most successful spaces and one of our favorite places. We think of
it as kind of the atpm “guest room.” This is where we will publish that sentimental
Macintosh story that you promised yourself you would one day write. It’s that special place
in atpm that’s specifically designated for your stories. We’d really like to hear from you.
Several Segments contributors have gone on to become atpm columnists. Send your stuff
to editor@atpm.com.
Hardware and Software Reviews
atpm publishes hardware and software reviews. However, we do things in a rather unique
way. Techno-jargon can be useful to engineers but is not always a help to most Mac users.
We like reviews that inform our readers about how a particular piece of hardware or software
will help their Macintosh lives. We want them to know what works, how it may help them
in their work, and how strongly we recommend it. Please contact our reviews editor, before
you begin writing, if you have a piece of hardware or software that you’d like to review.

Which Products Have You Reviewed?
Check our reviews index for the complete list.

What is Your Rating Scale?
atpm uses the following ratings (in order from best to worst): Excellent, Very Nice, Good,
Okay, Rotten. Products rated Good or better are ones that we recommend. Okay products
get the job done. We recommend avoiding Rotten products.

Will You Review My Product?
If you or your company has a product that you’d like to see reviewed, send a copy
our way. We’re always looking for interesting pieces of software to try out. Contact reviews@atpm.com for shipping information. You can send press releases to
news@atpm.com.
ATPM 17.07

64

FAQ

Where Can I Find Back Issues of ATPM?
Back issues of atpm, dating since April 1995, are available in DOCMaker stand-alone
format and as PDF. In addition, all issues since atpm 2.05 (May 1996) are available in
HTML format.

What If My Question Isn’t Answered Above?
We hope by now that you’ve found what you’re looking for (We can’t imagine there’s
something else about atpm that you’d like to know.). But just in case you’ve read this
far (We appreciate your tenacity.) and still haven’t found that little piece of information
about atpm that you came here to find, please feel free to e-mail us at (You guessed it.)
editor@atpm.com.
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